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Paper Set 1 · 08 Jun 2026 · 4:00 PM - 5:30 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
The ages of Ramesh and Suresh are in the ratio of 3 : 5. If Ramesh is
12 years old, what is the age of Suresh?

A.  15 years

B.  18 years

C.  20 years

D.  22 years

✓

Q2 Quant
A cyclist covers a fixed route of 72 km. If his speed is increased by 2
km/h, he arrives 30 minutes earlier. Find his original speed.

A.  12 km/h

B.  14 km/h

C.  16 km/h

D.  18 km/h

✓

Q3 Quant
A shopkeeper bought 300 writing pads for ₹15,000. The shopkeeper
wanted to sell them at a profit, so that they got 30 writing pads free.
At what profit percentage should it be sold?

A.  15%

B.  17%

C.  12%

D.  10%

✓

Q4 Quant
A man spends 10% of his monthly income on house rent, 22% on
food, and 23% on children education; he is then left with ₹8100. Find
his monthly income.

A.  ₹18,000

B.  ₹15,000

C.  ₹21,000

D.  ₹24,000

✓

Q5 Quant
Two partners P and Q invest ₹15,000 and ₹25,000, respectively, in a
business. After a year, the total profit is ₹16,000, which they share in
the ratio of their investments. What is the share of the profit of Q?

A.  ₹9,500

B.  ₹9,800

C.  ₹10,000

D.  ₹10,200

✓

Q6 Quant
A bus travels from Town A to Town B, a distance of 70 km, at a speed
of 30 km/h. At the same time, a motorcycle starts from Town B
towards Town A at 40 km/h. After meeting, the motorcycle reduces
its speed to 10 km/h and continues to Town A. Find the distance of
the motorcycle from Town A two hours after their meeting.

A.  10 km

B.  20 km

C.  25 km

D.  30 km

✓

Q7 Quant
A tank is filled by a pipe in 18 hours. Another pipe emptied it in 21
hours. If both pipes are opened together, in how many hours will the
tank be filled?

A.  88

B.  94

C.  112

D.  126

✓

Q8 Quant
Find the mode of the given set of numbers.

63, 87, 91, 78, 89, 36, 87, 98, 78, 63, 98, 79, 89, 36, 63

A.  79

B.  98

C.  89

D.  63
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✓

Q9 Quant
The sum of all interior angles of a regular polygon is 1620°. How
many sides does the polygon have?

A.  13

B.  12

C.  11

D.  10

✓

Q10 Quant
If 20% of a number is added to 54, then the result is the same
number. 80% of the same number is:331

A.  54

B.  64

C.  84

D.  74

✓

Q11 Quant
One pipe can fill a tank in 8 minutes while another pipe can empty
the completely filled tank in 32 minutes. If both the pipes are
opened together when the tank is empty, how many minutes will it
take to fill three-fourths of the tank?

A.  8

B.  16

C.  9

D.  17

✓

Q12 Quant
₹12,123 is divided among X, Y, and Z such that if ₹84, ₹47, and ₹64
are deducted from their respective shares, the remaining amounts
are in the ratio 3:7:11. Find X’s share after the deduction.

A.  ₹1704

B.  ₹1754

C.  ₹1554

D.  ₹1854

✓

Q13 Quant
In a division sum, the divisor is 20 times the quotient and 5 times
the remainder. If the remainder is 76, what is the dividend?2909

A.  7296

B.  7301

C.  7292

D.  7295

✓

Q14 Quant
Amit invested the same amount in two schemes: one at simple
interest and the other at compound interest, both at 10% per year
for 2 years. At the end, the compound interest was ₹40 more than
the simple interest. Find the amount (in ₹) he invested in each
scheme.

A.  4000

B.  5000

C.  6000

D.  8000

✓

Q15 Quant
The arithmetic mean of the observations 26, 25, 55, 41, 29, 64, 86, 56
and 32 is:

A.  46

B.  37

C.  55

D.  50

✓

Q16 Quant
The ratio between the perimeter and the breadth of a rectangle is 4 :
1. If the area of the rectangle is 289 cm2, find the perimeter (in cm)
of the rectangle.2296

A.  68

B.  72

C.  64

D.  60

✓

Q17 Quant
Ranjith bought two mobiles at the same price. He sold one at a
profit of 20% and the other at a loss of 10%. What is his overall
percentage of profit?

A.  5%

B.  6.5%

C.  6%

D.  5.5%
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✓

Q18 Quant
A solid sphere of radius 9 cm is melted and drawn into a wire of uniform circular cross-section with radius 1 cm. What is the length of the wire?

[Use π = ]

A.  9.12 m

B.  9.32 m

C.  9.72 m

D.  9.92 m

✓

Q19 Quant
If a+b+c=16 and ab+bc+ac=39, find the value of  .

A.  178

B.  100

C.  149

D.  134

✓

Q20 Quant

A.  

B.  

C.  

D.  
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GA

✓

Q21 GA
Who among the following became India’s fastest man by breaking
the national record in the men’s 100 metres at Dromia International
Sprint and Relays Meeting 2025?

A.  Gurindervir Singh

B.  Animesh Kujur

C.  Mohammed Afsal

D.  Jinson Johnson

✓

Q22 GA
The Rajmahal hills are located in which state of India?

A.  Rajasthan

B.  Meghalaya

C.  Jharkhand

D.  Telangana

✓

Q23 GA
Who is the Chief Minister of Odisha as of September 2025?

A.  Pradeep Kumar Amat

B.  Biswa Bhusan Harichandan

C.  Naveen Patnaik

D.  Mohan Charan Majhi

✓

Q24 GA
The 25th Bharat Rang Mahotsav (BRM), known as the world’s largest
theatre festival that brought exciting theatre performances to
multiple cities across India, is organised by which institution?

A.  National School of Drama

B.  Sangeet Natak Akademi

C.  Indira Gandhi National Centre for the Arts

D.  Indian Council for Cultural Relations

✓

Q25 GA
A convex lens forms an image 30 cm from the lens when an object is
placed 15 cm in front of it. The object height is 5 cm. If the resulting
magnification is calculated as m = −2, what is the image height and
the nature of the image?

A.  Image height 10 cm, Virtual and erect

B.  Image height −10 cm, Real and inverted

C.  Image height −2.5 cm, Real and inverted

D.  Image height 10 cm, Real and inverted

✓

Q26 GA
Why does carbon form covalent bonds instead of ionic bonds?

A.  It has a tendency to lose four electrons easily

B.  It cannot lose or gain four electrons easily, so it shares
electrons

C.  It has a tendency to gain four electrons easily

D.  It has a complete outer shell

✓

Q27 GA
Which among the following is INCORRECTLY paired regarding the
boundaries of the Thar Desert in India?

A.  Northwest – Luni River

B.  East – Aravalli Range

C.  South – Rann of Kutch

D.  West – Indus River

✓

Q28 GA
Complete the given analogy based on parts of the digestive system
and their secretions in human beings.

Mouth: Salivary amylase :: Stomach:?

A.  Lipase

B.  Trypsin

C.  Pepsin

D.  Amylase

✓

Q29 GA
At the first “Femina Achievers Awards 2025: Odisha Edition”, which
of the following names was recognised for Excellence in Music?

A.  Adyasha Satpathy

B.  Ankita Mohanty

C.  Antara Chakraborty

D.  Arpita Mohapatra

✓

Q30 GA
The traditional painting style of Odisha, known for its depiction of
Lord Jagannath and mythological themes, is called:

A.  Warli

B.  Pattachitra

C.  Kalamkari

D.  Madhubani
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✓

Q31 GA
The definition of sustainable development was systematically
defined in which report?

A.  Rio Declaration

B.  Our Common Future

C.  Kyoto Protocol

D.  Limits to Growth

✓

Q32 GA
Which region of Odisha experiences the highest humidity?

A.  Coastal region

B.  Plateau region

C.  Hilly region

D.  Forest areas

✓

Q33 GA
During the Gandhian phase of the national movement (1919–1947),
which of the following movements was launched by Mahatma
Gandhi in direct response to the failure of the Simon Commission
and the demand for complete independence?

A.  Non-Cooperation Movement

B.  Civil Disobedience Movement

C.  Quit India Movement

D.  Khilafat Movement

✓

Q34 GA
Which team emerged as the champion of the ICC Women’s World
Cup 2025?

A.  Australia

B.  England

C.  South Africa

D.  India

✓

Q35 GA
Which Indian state launched its inaugural drug and caste socio-
economic study on April 1, 2026, to chart living conditions, examine
unemployment trends, and evaluate the extent of drug abuse?

A.  Punjab

B.  Rajasthan

C.  Bihar

D.  Maharashtra

✓

Q36 GA
Which of the following statements best describes the Directive
Principles of State Policy in the Indian Constitution?

A.  They are enforceable by courts.

B.  They are guidelines for the government to frame policies.

C.  They are applicable only during emergencies.

D.  They apply only to the central government.

✓

Q37 GA
Which of the following classical dance forms originated from Tamil
Nadu?

A.  Kathak

B.  Bharatanatyam

C.  Manipuri

D.  Sattriya

✓

Q38 GA
Which of the following folk/tribal dances is correctly matched with
the main region in which it is associated?

A.  Santhali Dance – Gujarat

B.  Bison-Horn Maria dance – Chhattisgarh

C.  Giddha – Kerala

D.  Chhau – Goa

✓

Q39 GA
The Bhabar belt lies parallel to which mountain range?

A.  Aravalli Range system

B.  Vindhya Range system

C.  Shiwalik Foothills system

D.  Western Ghats system

✓

Q40 GA
Dr Mahbub ul Haq, a renowned economist associated with the
concept of Human Development, was a native of which nation?

A.  Pakistan

B.  Iran

C.  Saudi Arabia

D.  Afghanistan
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English

✓

Q41 English
Select the appropriate option to complete the sentence.

It was ___ honor to meet ___ astronaut who visited our school.1619

A.  a, an

B.  an, a

C.  an, an

D.  a, a

✓

Q42 English
Select the option that can be used as a one-word substitute for the given group of words.

The fear of open or public spaces

A.  Claustrophobia

B.  Agoraphobia

C.  Xenophobia

D.  Acrophobia

✓

Q43 English

Select the correct Active form of the following sentence.

The house was cleaned by Sarah every Sunday.

A.  Sarah cleaned the house every Sunday.

B.  Sarah will clean the house every Sunday.

C.  Sarah is cleaning the house every Sunday.

D.  Sarah has cleaned the house every Sunday.

✓

Q44 English
Select the most appropriate idiom to replace the underlined words in the sentence below.

The firefighters reached the burning building at the last possible moment to save the people trapped inside.

A.  in the nick of time

B.  like a blessing in disguise

C.  once in a blue moon

D.  under the weather

✓

Q45 English
Identify the sentence from the options that is incorrectly written in indirect speech.

A.  She said that she had finished her homework.

B.  She said that she has finished her homework.

C.  She said that she would call me later.

D.  She said that she was feeling unwell.
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✓

Q46 English
Choose the option that can substitute the underlined idiom seamlessly.

After hours of discussion, she finally bit the bullet and accepted the responsibility.

A.  faced the difficulty

B.  ignored the issue

C.  ran away

D.  postponed the decision

✓

Q47 English
Choose the correct form of past tense of the verb given in the bracket to complete the given sentence.
I __________ (excite) to share how I met my new friend.

A.  had excitement

B.  am excited

C.  had been excited

D.  was exciting

✓

Q48 English

Read the passage and answer the questions that follow.

Summer is a popular time for pilgrimage in India, as it coincides with several religious festivals and offers favourable weather conditions for
travel to many sacred sites. These pilgrimage destinations in India offer not just spiritual solace but also an opportunity to immerse oneself in
the rich cultural heritage and traditions that define the country's religious landscape. Whether braving treacherous mountain trails or seeking
solace in serene temple towns, pilgrims embark on a journey of self-discovery and enlightenment, guided by unwavering faith and devotion.

Vaishno Devi Temple, nestled in the picturesque Trikuta Mountains in Katra, Jammu, is dedicated to Goddess Vaishno Devi. Pilgrims embark on a
challenging trek, covering approximately 13 kilometres from the base camp at Katra to the temple located at an altitude of around 5,200 feet.
The journey, though strenuous, is undertaken with unwavering faith and devotion.

Select an appropriate title for the passage.

A.  The Summer Sun

B.  Faith on the Mountain Trails

C.  Trek to the Northern Peaks

D.  India’s Summer Pilgrimages of Devotion

✓

Q49 English
Select an appropriate structure of the passage.

A.  Description

B.  Comparison

C.  Argument

D.  Narrative
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✓

Q50 English
Select an appropriate meaning of the word: TREACHEROUS

A.  Smooth

B.  Dangerous

C.  Pleasant

D.  Effortless

✓

Q51 English
Select the most appropriate theme of the passage.

A.  Spiritual journeys that blend devotion with endurance

B.  The architectural styles of Indian temples

C.  Weather conditions affecting Indian tourism

D.  Myths surrounding Indian deities

✓

Q52 English
Select an appropriate inference drawn from the passage.

A.  Pilgrimage in India is both a test of endurance and a spiritual pursuit.

B.  People travel mainly for adventure rather than faith.

C.  The summer season discourages religious travel.

D.  The Vaishno Devi trek is purely recreational.

✓

Q53 English
Sentences of a paragraph are given below. While the first sentence (A) is in the correct order, the sentences below it are jumbled up. Arrange
the sentences in the correct order to form a meaningful and coherent paragraph.

A. Climate change is one of the most pressing challenges facing the world today.
B. Many countries are investing in renewable energy to reduce carbon emissions.
C. Scientists warn that failure to act now could lead to irreversible damage.
D. Rising global temperatures are causing glaciers to melt and sea levels to rise.
E. Governments and individuals must work together to create sustainable solutions.

A.  ABCDE

B.  ACDBE

C.  ADBCE

D.  AEDCB

✓

Q54 English
Choose the correct antonym for the underlined word from the options.
The scientist learnt to manipulate the data carefully to reveal meaningful patterns and insights.

A.  mishandle

B.  break

C.  boost

D.  anticipate
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✓

Q55 English
Identify the misspelt word in the given sentence.

The engineers discussed the feasable methods for storing excess solar energy during peak production.

A.  feasable

B.  storing

C.  excess

D.  peak

✓

Q56 English
Identify the antonym of the highlighted word in the sentence.

The once arid land was transformed into a fertile field through irrigation.

A.  Rocky

B.  Elevated

C.  Moist

D.  Dusty

✓

Q57 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

A. in the tranquil garden
B. the old oak tree stands tall
C. providing shade and solace
D. to those seeking refuge

A.  ABCD

B.  BADC

C.  ABDC

D.  DCAB

✓

Q58 English
Select the most appropriate option to fill in the blank.

By next year, she ______ in this company for a decade.

A.  will have worked

B.  have worked

C.  worked

D.  will work
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✓

Q59 English
Select the option that can be used as a one-word substitute for the highlighted group of words.

She tried to pretend to feel or be affected by something, especially an emotion or illness, but her lack of real tears gave her away.

A.  Reveal

B.  Feign

C.  Express

D.  Confess

✓

Q60 English
Select the most appropriate option to fill in the blank.

The scientist’s theory, though radical, was supported by ______ data that few in the academic community could refute.

A.  speculative

B.  irrefutable

C.  fragmented

D.  circumstantial

Odia

✓

Q61 Odia
ଭବି ଷ୍ୟତରେ ସେ ଜଣେ ଡାକ୍ତର ହେବେ - ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଏହି  ବାକ୍ୟର ଠି କ୍  ଅନୁ ବାଦ ବାଛ ।

A.  In future, he will become a doctor.

B.  He will become a doctor in the future.

C.  He will become a doctor in future.

D.  He will become an doctor in future.

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ଶବ୍ଦଗୁ ଡ଼ି କର ସମାନାର୍ଥ ବୋଧକ ଶବ୍ଦ ଲେଖ।
ପି ଲାମାନେ ଖେଳୁ ଥି ବା ବେଳେ ବହୁ ତ "ଆନନ୍ଦ" ଅନୁ ଭବ କରନ୍ତି ।

A.  ଦୁଃ ଖ

B.  ଖୁ ସି

C.  କ୍ରୋ ଧ

D.  ଭୟ

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଭାରତ ଏକ ବହୁ  ଧର୍ମୀ ୟ ଦେଶ ଯେଉଁ ଠାରେ ବି ଭି ନ୍ନ ଲୋକ ଭି ନ୍ନ ଆସ୍ଥା ମାନି ଥାନ୍ତି  ।

A.  India is a multi-religious country where people practice different faiths freely.

B.  India is multi-religious country where people practice different faiths freely.

C.  India are a multi-religious country where people practice different faiths freely.

D.  India is a multi-religious country where people practices different faiths freely.
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✓

Q64 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ରାଷ୍ଟ୍ରପତି  ଆଜି  କେରଳ ଗସ୍ତରେ ଯି ବେ।

A.  The President has visited Kerala today.

B.  The President will visit Kerala today.

C.  The President will visit Kerala .

D.  The President was visiting Kerala today.

✓

Q65 Odia

ନି ମ୍ନୋ କ୍ତ ଅନୁ ଚ୍ଛେଦକୁ  ପଢି  ପ୍ର ଶ୍ନ ଗୁ ଡି କର ଉତ୍ତର ଚୟନ କର ।

ସାରା ଦେଶରେ ଦି " ଓଳି  ଦି ' ମୁ ଠା ଖାଇବାକୁ  ପାଇ ନଥୁ ବା ଅଗଣି ତ ମଣି ଷଙ୍କୁ  ଦେଖି  ବି ବେକାନନ୍ଦ ଗୋଟି ଏ ନୂ ତନ ଜ୍ଞାନ ପାଇଲେ । ତାହା ହେଉଛି , “ଭୋକି ଲା ପେଟରେ ଧର୍ମ  ଅନାବଶ୍ୟକ’ । ଉକ୍ତି ଟି

ମାର୍କ ସ ବା ତାଙ୍କର ଅନୁ ଗାମୀଙ୍କର ବୋଲି  ଅନୁ ମାନ କରି ନେବା ସ୍ଵାଭାବି କ । କି ନ୍ତୁ ଏ ପଦଟି  ନରେନ୍  ରାମକୃ ଷ୍ଣଙ୍କ ଠାରୁ  ଶୁ ଣି ଥି ଲେ । ଦେଶର ଅନ୍ଦି କନ୍ଦି  ବୁ ଲି  ଏହାର ସତ୍ୟତାକୁ  ମର୍ମେ  ମର୍ମେ  ଅନୁ ଭବ
କଲେ । ସେ ଠି କ୍  କଲେ, ଦରି ଦ୍ର ନାରାୟଣଙ୍କ ସେବା ହିଁ ସନ୍ନ୍ୟାସୀର ଯଥାର୍ଥ  ବ୍ର ତ । ଦେଶସାରା ଦାରି ଦ୍ର୍ୟ ର ନି ରଙ୍କୁ ଶ ରାଜତ୍ଵ ଦେଖି  ବି ବେକାନନ୍ଦ ଆପଣାକୁ  ଓ ସନ୍ନ୍ୟାସୀକୁ  ଧି କ୍ ‌କାର କରି  ଭାବୁ ଥି ଲେ “
ବୁ ଭୁ କ୍ଷୁ  ଜନତା ପାଇଁ  ଆମେ ସନ୍ନ୍ୟାସୀଗଣ କ’ଣ କରି ଛୁ  ?’’ ଜୟ ପରାଜୟ ଊର୍ଦ୍ଧ କୁ  ଉଠି ଥ‌ି ବା ଅନାସକ୍ତ ସନ୍ନ୍ୟାସୀ ବ୍ୟତୀତ ଆଉ କି ଏ ପ୍ର ବଳ ପ୍ର ତାପୀ ଓ ଅଜେୟ ଦାରି ଦ୍ର୍ୟ  ଦାନବ ବି ରୋଧରେ ଖଡ୍ ‌ଗ
ଉତ୍ତୋଳନ କରି ପାରେ ? ଯୁ ଗ ଯୁ ଗ ଧରି  ସିଂ ହାସନରେ ଅଧି ଷ୍ଠି ତ ପ୍ର ତାପୀ ସମ୍ରା ଟଙ୍କ ବି ରୋଧରେ ସଂଗ୍ରା ମର ଫଳାଫଳକୁ  ନି ଜର ଶୌର୍ଯ୍ୟ ବୀର୍ଯ୍ୟ  ଦ୍ଵାରା ନ ମାପି  ସୁ ପ୍ତ କାତି ର ଶକ୍ତି  କଳି ଥି ବା ଦି ବ୍ୟଦଷ୍ଟା

ସନ୍ନ୍ୟାସୀ ବ୍ୟତୀତ ଆଉ କି ଏ ରଣଦୂ ନ୍ଦୁ ଭି  ବଜାଇ ଯୁ ଦ୍ଧର ଡାକରା ଦେଇପାରେ ? ଏ ଦାନବ ପାଇଁ  ଦଧି ଚି ଙ୍କ ପରି  ଜଣେ ମହର୍ଷିଙ୍କ ଅସ୍ଥି ରେ ନି ର୍ମିତ ଅମୋଘ ଅସ୍ତ୍ର ମଧ୍ୟ ଯଥେଷ୍ଟ ନୁ ହେଁ  ! ମଣି ଷଙ୍କର
ଦୀର୍ଘ ଶ୍ଵାସ ଓ ଅଶ୍ରୁ ରୁ  ଶତ୍ରୁ  ସଂହାର ଅସ୍ତ୍ର ଜାଣି ଥି ବା ତରୁ ଣ ସନ୍ନ୍ୟାସୀ। ପ୍ର ତି ଟି  ଆର୍ତ୍ତ ନାଦ ଓ ପ୍ର ତି ବୁ ନ୍ଦା ଅଶ୍ରୁ କୁ  ସଂଗ୍ର ହ କରି  ତାଙ୍କ ବି ଶାଳ ହୃ ଦୟରେ ସଞ୍ଚି  ରଖି ବା ପାଇଁ  ଆକୁ ମାରୀହି ମାଚଳ ପଦବ୍ର ଜରେ

ବୁ ଲି ଥି ଲେ । ଯାତ୍ରା  ଆରମ୍ଭ ହୋଇଥି ଲା ବରାହନଗରରୁ  । କେଉଁ ଠି  ଯାଇ ରାଜପୁ ତନା, ଜୟପୁ ର, ଆଜ୍ ‌ମୀର । ସେଠାରୁ  ପୁ ଣି  ଜୁ ନାଗଡ଼, ପୋରବନ୍ଦର, ଦ୍ଵାରକା, ବମ୍ବେ, ପୁ ନା । ଶେଷରେ ବି ବେକାନନ୍ଦ
ଦକ୍ଷି ଣରେ ପହଞ୍ଚି ଥି ଲେ । ସାରା ଦେଶରେ ଏହି  ଅଚି ହ୍ନା ସନ୍ନ୍ୟାସୀ ଅନେକ ଗୁ ଣମୁ ଗ୍ ‌ଧ ବନ୍ଧୁ , ସହକର୍ମୀ  ଓ ଅନୁ ଗତ ଶି ଷ୍ୟ ସୃ ଷ୍ଟି  କରି ଥି ଲେ ମଧ୍ୟ ମାଡ୍ରା ସରେ ତାଙ୍କର ପ୍ର ଭାବ ବି ଶେଷ ଭାବେ ଅନୁ ଭୂ ତ

ହୋଇଥି ଲା । ଯୁ ଦ୍ଧ ଘୋଷଣା କରି ବା ପୂ ର୍ବ ରୁ  ଛତ୍ର ପତି  ସନ୍ନ୍ୟାସୀ ବେଶରେ ତାଙ୍କର ଯୋଦ୍ଧାମାନଙ୍କୁ  ଠାବ କରି ଗଲେ । ଧନୀ ରାଜା ମହାରାଜା ବଡ଼ ବଡ଼ ପଣ୍ଡି ତମାନଙ୍କଠାରୁ  ଆରମ୍ଭ କରି  ସାଧାରଣ ଜନତା
ମଧ୍ୟରେ ଥି ବା ଅନୁ ରକ୍ତ ସୈ ନି କମାନେ ଏହି  ଛଦ୍ମ ବେଶୀ ଛତ୍ର ପତି ଙ୍କଠାରୁ  କି  ଏକ ରହସ୍ୟମୟ ଇସାରା ପାଇ ଆଦେଶକୁ  ଅପେକ୍ଷା କରି  ରହି ଲେ । ଧନୀ, ଦରି ଦ୍ର , ମୂ ର୍ଖ , ପଣ୍ଡି ତ, ନି ର୍ବିଶେଷରେ ଏତେ

ଲୋକ ଜଣେ ନିଃ ସ୍ଵ ସନ୍ନ୍ୟାସୀ ପ୍ର ତି  ଆକୃ ଷ୍ଟ ହୋଇଥି ଲେ କାହିଁକି  ? କି ଛି  ହଟଚମକ ବି ଦ୍ୟା ଦେଖି  ନୁ ହେଁ  କି ମ୍ବା ‘ମୋ ଶି ଷ୍ୟ ହେଲେ ବା ମୋତେ ପୂ ଜା କଲେ ଆଉ ଗୋଟାଏ ବଡ଼ ରାଜ୍ୟ ମି ଳି ବ, ବଡ଼
ଚାକି ରି  ମି ଳି ବ’-ଏପରି  ପ୍ର ତି ଶ୍ରୁ ତି  ପାଇ ନୁ ହେଁ  । କ’ଣ ପାଇଁ , କି  ଶକ୍ତି  ଦେଖି  ତାଙ୍କ ସଂସ୍ପର୍ଶ ରେ ଆସୁ ଥି ବା ଲୋକଙ୍କର ବଞ୍ଚି ବାର ଢଙ୍ଗ ବଦଳି  ଯାଉଥି ଲା

ଅନୁ ଛେଦଟି ର ଗଢଣଟି କୁ  ଚୟନ କର ।

A.  ଶି କ୍ଷା ଓ ସଂସ୍କୃତି

B.  ସତ୍ୟ ଓ ନ୍ୟାୟ

C.  ମଣି ଷର ସଭ୍ୟ ଆଚରଣ

D.  ମାତୃ ଭାଷା ଓ ଲୋକଶି କ୍ଷା

✓

Q66 Odia
ଏହି  ଅନୁ ଛେଦଟି ରେ କେଉଁ  ସ୍ଵରକୁ  ଅଧି କ ଗୁ ରୁ ତ୍ଵ ଦି ଆଯାଇଛି  ?

A.  ପ୍ରେ ମ

B.  ଦୟା

C.  ସମ୍ପର୍କ  ଓ ଭଲପାଇବା

D.  ସହାନୁ ଭୁ ତି

✓

Q67 Odia
ଯୁ ଦ୍ଧ ଘୋଷଣା କରି ବା ପୂ ର୍ବ ରୁ  ଛତ୍ର ପତି  କେଉଁ  ବେଶରେ ଯୋଦ୍ଧାମାନଙ୍କୁ  ଠାବ କରି ଥି ଲେ ବୋଲି  କୁ ହାଯାଇଛି  ?

A.  ନାରୀ ବେଶ

B.  ବ୍ରା ହ୍ମଣ ବେଶ

C.  ପାରମ୍ପରି କ ବେଶ

D.  ସନ୍ନ୍ୟାସୀ
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✓

Q68 Odia
‘ଭୋକି ଲା ପେଟରେ ଧର୍ମ  ଅନାବଶ୍ୟକ’- ଏହି  ଉକ୍ତି ଟି  ନରେନ୍  କାହାଠୁ  ଶୁ ଣି ଥି ଲେ ?

A.  ବି ବେକାନନ୍ଦ

B.  ମାର୍କ ସ

C.  ମହାତ୍ମା ଗାନ୍ଧୀ

D.  ରାମକୃ ଷ୍ଣ

✓

Q69 Odia
ଜଣେ ସଭ୍ୟ ମଣି ଷ ଭାବେ କି ପରି  ପରି ଚି ତ ହୁ ଏ ?

A.  ଅସଭ୍ୟତା ଦ୍ୱାରା

B.  ଶି ଷ୍ଟ ଓ ସଂସ୍କାରୀ

C.  ଅଳସ

D.  ଅନି ୟମି ତ

✓

Q70 Odia
ତୁ ମେ ଯି ବ ଯେ କଥାଟି  କି ନ୍ତୁ କଥା ଭଲ ହେବନି  । ଏହି  ବାକ୍ୟରେ "ଯେ" ଶବ୍ଦଟି  କେଉଁ  ପ୍ର କାରର ଅବ୍ୟୟ ?

A.  ସମ୍ମତି ସୂ ଚକ ଅବ୍ୟୟ

B.  ବି ସ୍ମୟସୂ ଚକ ଅବ୍ୟୟ

C.  ବି କଳ୍ପାର୍ଥ କ ଅବ୍ୟୟ

D.  ଆଳଙ୍କାରି କ ଅବ୍ୟୟ

✓

Q71 Odia
ତତ୍ସମ ଶବ୍ଦଟି କୁ  ଚି ହ୍ନି ତ କର ?

A.  ଦହି

B.  ଥନ

C.  ଉକୁ ଣି

D.  ନଦୀ

✓

Q72 Odia
"ମାଆ ଶି ଶୁ କୁ  ଚାନ୍ଦ ଦେଖାଉଛନ୍ତି " - ଏହି  ବାକ୍ୟରେ 'ଦେଖାଉଛନ୍ତି ' କେଉଁ  ପ୍ର କାର କ୍ରି  ୟା?

A.  ମୌଳି କ କ୍ରି  ୟା

B.  ପ୍ରେ ରଣାର୍ଥ କ କ୍ରି  ୟା

C.  ନାମଧାତୁ  କ୍ରି  ୟା

D.  ଅକର୍ମ କ କ୍ରି  ୟା
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✓

Q73 Odia
"ତାଙ୍କର 'ଆବି ର୍ଭା ବ' ଯେତି କି  ଆଶ୍ଚର୍ଯ୍ୟ ଜନକ ଥି ଲା, '________' ସେତି କି  ଦୁଃ ଖଦାୟକ ଥି ଲା।"
(ନି ମ୍ନ ରେ ପ୍ର ଦତ୍ତ ଶବ୍ଦ ମଧ୍ୟରୁ  ସଠି କ ଶବ୍ଦ ବ୍ୟବହାର କରି  ଶୂ ନ୍ୟସ୍ଥାନ ପୂ ରଣ କର)

A.  ପ୍ର ସ୍ଥାନ

B.  ତି ରୋଧାନ

C.  ବି ଦାୟ

D.  ବି ଲୟ

✓

Q74 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  'ବି ଯୋଜକ ଅବ୍ୟୟ' କି ଏ ?

A.  ଏବଂ

B.  କି ମ୍ବା

C.  କାରଣ

D.  ତେଣୁ

✓

Q75 Odia
"ଧୀରପାଣି  ପଥର କାଟେ"- ଏହି  ଲୋକୋକ୍ତି ର ଠି କ୍  ଅର୍ଥ  କି ଏ ?

A.  ତୁ ରନ୍ତ କାମ କରି ବା ଉଚି ତ

B.  କି ଛି  କାମ କରି ବା ଆବଶ୍ୟକ ନାହିଁ

C.  ଧୀର ସ୍ଥି ର ଭାବେ କାର୍ଯ୍ୟ  କଲେ ସଫଳତା ମି ଳେ

D.  ଭୟ କରି ବା ଉଚି ତ ନୁ ହେଁ

Computer

✓

Q76 Computer
What is the first step in creating a new document in MS Word?

A.  Select File → Open

B.  Select File → New

C.  Press Ctrl + S

D.  Click Insert → New Page

✓

Q77 Computer
Which option allows setting uniform margins for a document in MS
Word 2021?

A.  Page Number

B.  Paragraph

C.  Margins

D.  Header

✓

Q78 Computer
Which tab in PowerPoint allows you to choose the setup for
presenting slides?

A.  Home

B.  Insert

C.  Slide Show

D.  View

✓

Q79 Computer
While designing a detailed sales ledger, Neha increases the width of
column B to accommodate lengthy customer remarks. Despite
repeatedly dragging the column boundary, MS Excel stops resizing
further. She encounters this because Excel imposes a maximum
column width of:

A.  255 characters

B.  512 characters

C.  1024 pixels

D.  300 points
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✓

Q80 Computer
Which type of computer memory is volatile, meaning it loses all its
stored data as soon as the computer's power is turned off?

A.  Read-Only Memory (ROM)

B.  Random Access Memory (RAM)

C.  Hard Disk Drive (HDD)

D.  Solid State Drive (SSD)

✓

Q81 Computer
Which of the following is classified as a pointing input device?

A.  Plotter

B.  Trackball

C.  Speaker

D.  Inkjet Printer

✓

Q82 Computer
What will the formula =TODAY() return when entered in a blank
worksheet?

A.  The word 'Today'

B.  The current time

C.  The total number of days in the month

D.  The current date according to the system clock

✓

Q83 Computer
Which of the following combinations correctly matches the devices
with their respective categories?

A.  Mouse – Output, Printer – Input

B.  Monitor – Input, Microphone – Output

C.  Keyboard – Input, Speaker – Output

D.  Scanner – Output, Braille Keyboard – Output

✓

Q84 Computer
What does PCB stand for in a computer?

A.  Printed Circuit Board

B.  Peripheral Component Board

C.  Primary Control Board

D.  Programmed Chip Base

✓

Q85 Computer
Which of the following is a feature of LAN?

A.  Covers a city

B.  Covers the entire globe

C.  Covers a small geographical area

D.  Requires satellite

✓

Q86 Computer
Where can you enter text for a slide other than directly in the
placeholder on the Slide Pane?

A.  In the Transition Pane

B.  In the Notes Pane

C.  In the Outline tab of the Overview Pane

D.  In the Header and Footer Dialog

✓

Q87 Computer
What is the purpose of 'Slide Transition'?

A.  To add audio

B.  To animate text

C.  To change from one slide to another with effects

D.  To format text

✓

Q88 Computer
If your file is greater than 25 MB, Gmail automatically adds a
__________ in the email instead of including it as an attachment.

A.  Link

B.  Attachment Link

C.  Google drive link

D.  Local drive link
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✓

Q89 Computer
In order to print multiple MS Excel workbooks simultaneously, which
of the following conditions must be satisfied?

A.  All files must first be saved as PDF documents.

B.  The workbooks should be saved in different folders.

C.  All workbooks must be stored in the same folder.

D.  Each workbook must be opened in a separate Excel window.

✓

Q90 Computer
Which group under the Layout tab in MS Word provides options to
adjust settings such as margins, page orientation and paper size?

A.  Paragraph

B.  Page Setup

C.  Styles

D.  Font

Reasoning

✓

Q91 Reasoning
G is the mother of H. H is the husband of J. J is the sister of K. L is the
father of K. How is G related to L?
1715

A.  Daughter's mother

B.  Daughter's husband's mother

C.  Daughter's husband's sister

D.  Daughter's daughter

✓

Q92 Reasoning
Q, W, E, R, T, Y and U are sitting around a circular table facing the
centre. R is the immediate neighbour of T and Y. E sits to the
immediate right of T. U is not an immediate neighbour of E and W.
Who among the following are immediate neighbours of U?2269

A.  R and Y

B.  Q and Y

C.  E and R

D.  T and Y

✓

Q93 Reasoning
Each of S, T, U, V, M, N and O has an exam on a different day of a
week, starting from Monday and ending on Sunday of the same
week. S has exam on Friday. Only two people have exam between N
and S. Only four people have exam between U and N. O has exam
just after T. M doesn’t have exam on Monday.
How many people have exam between M and V?

A.  One

B.  Two

C.  Three

D.  Four

✓

Q94 Reasoning
If 1 is added to each odd digit and 2 is subtracted from each even
digit in the number 7438156, what will be the sum of the digits
which are second from the left and second from the right in the new
number thus formed?

A.  8

B.  10

C.  14

D.  12
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Q95 Reasoning
TT 14 is related to WX 25 in a certain way. In the same way, QE 17 is
related to TI 28. To which of the following is VN 27 related, following
the same logic?

A.  UH 78

B.  HY 76

C.  HG 65

D.  YR 38

✓

Q96 Reasoning
Which of the following letter-number clusters will replace the
question mark (?) in the given series to make it logically complete?

MVK 1 NSI -2 OPG 4 PME -8 ?

A.  QJC 16

B.  PME -8

C.  BHG -9

D.  NHT -2

✓

Q97 Reasoning
Kartik starts from Point A and drives 10 km towards the north. He
then takes a left turn, drives 8 km, turns left and drives 14 km. He
then takes a left turn and drives 12 km. He takes a final left turn,
drives 4 km and stops at Point P. How far (shortest distance) and
towards which direction should he drive in order to reach Point A
again? (All turns are 90-degree turns only unless specified.)

A.  4 km to the west

B.  4 km to the east

C.  5 km to the west

D.  5 km to the east

✓

Q98 Reasoning
Based on the alphabetical order, three of the following four are alike
in a certain way and thus form a group. Which is the one that does
not belong to that group? (Note: The odd man out is not based on
the number of consonants/vowels or their position in the letter
cluster)11726

A.  EFA

B.  QPM

C.  XWT

D.  CBY

✓

Q99 Reasoning
Read the given statement(s) and conclusions carefully. Assuming
that the information given in the statements is true, even if it
appears to be at variance with commonly known facts, decide which
of the given conclusions logically follow(s) from the statement(s).

Statement: All vases are spoons. No spoon is a rose.

Conclusion I: No rose is a vase.
Conclusion II: Some roses are vases.

A.  Only conclusion (I) follows

B.  Only conclusion (II) follows

C.  Neither conclusion (I) nor (II) follows

D.  Both conclusions (I) and (II) follow

✓

Q100 Reasoning
Each vowel in the word COLLEGE is changed to the letter
immediately following it in the English alphabetical order and each
consonant is changed to the letter immediately preceding it in the
English alphabetical order. Which of the following letters will be third
from the left in the new group of letters thus formed?

A.  K

B.  F

C.  P

D.  B
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